
the menu setting, the voice recording will be cut off when played.
5	 To create another slide, select the “Add Slide” icon . Add up to five 

slides by repeating Step 4.
6	 To preview your message, select the Preview button. You can edit the 

attachments from the Compose screen: first highlight the attachment, 
then press the trackball to bring up the context menu containing edit 
options.

7	 When ready to send, either select the Send button at the bottom of the 
Compose screen, or press MENU  + M.

Send an Audio Postcard
Audio postcards are a great way to show your friends what you’re up to—
take a photo and add a personalized voice message before sending. Audio 
postcards can be sent from within the Call Log and the picture messaging, 
camera, address book, and myFaves applications. The following steps walk 
you through sending an audio postcard from within picture messaging.

1	 Press JUMP  to go to the Jump screen. Scroll to highlight Phone 
Messaging, then press the trackball to open the second-level ring of 
applications. Highlight Picture Messaging, then press the trackball.

2	 Press MENU  to open the Picture Messaging menu. Select New Audio 
Postcard then press the trackball.

3	 The camera capture screen displays. For instructions on capturing 
a photo, read “Take a Photo” on page 69. You can either take a new 
photo or select a photo from your album. After you have selected a 
photo, click DONE .

4	 The Select Picture Frame screen appears. Use D-pad left and right to 
change the postcard frame. You can also D-pad up and down to zoom. 
Click DONE  when you are finished.

5.	 On the Compose Postcard screen click the Add Voice Note button 
to add a voice message to your Audio Postcard. By default, the Start 
Recording button is selected. You can record a message up to 20 
seconds long. Click Stop Recording to end your recording. To preview 
your recording, click the play button. If you are satisfied with your 
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recording click DONE  or otherwise click the Re-record button.
6.	 Add a To address and Subject to your Audio Postcard. 
7.	 You can change the photo frame on the Compose Postcard Screen by 

using the trackball to select Click to change frame on the photo. Click 
DONE  to return to the Compose Postcard screen 

8.	 Press MENU  to save your draft, select a new frame and/or photo or 
add more recipients.

9.	 When you are done editing your audio postcard, press MENU  and 
select Send.

Web Browser  

Browse the Web
1	 Press JUMP  to go to the Jump screen. Scroll to highlight Web 

Browser, then press the trackball.
2	 Start typing the address of the Web page you wish to visit. The Go 

To dialog box opens and is populated while you type. Possible URL 
matches, and the option to search for the text you type, appear in the 
drop-down menu. 

3	 To go to a Web page, you can either finish typing the complete URL in 
the Go To dialog box then press Return; or, roll the trackball to highlight 
a suggested URL in the drop-down menu, then press the trackball. 

   To open Web pages faster, press MENU  and select Settings. Scroll 
down the Settings screen and clear the “Show images” check box.

   To increase/decrease the text size displayed on a page, press MENU 
 and select View > Text Size.

52	 Using the Applications



Bookmark a Web Page
To open the list of bookmarks, press MENU  and select Bookmarks or 
press MENU  + K. To add a bookmark:

1	 Open the Web page you want to bookmark.
2	 Press MENU  + N to open the Add Bookmark dialog box.
3	 Edit the bookmark name if you wish, verify the URL, and select a folder 

in which to store the bookmark from the Folder pop-up menu. (If you 
select New Folder, you’ll be prompted to type a folder name.)

4	 Press DONE  to save the bookmark.

Copy Text on a Web Page
You can copy all the text on a Web page by pressing MENU  + A, then 
MENU  + C. Copy only specific text you highlight by doing the following:

1	 Press MENU  and select Edit Text > Text Selection Mode. Alternatively 
you can press the SHIFT key while rolling the trackball. Either method 
will put you in “text mode”. A blinking cursor (|) appears.

2	 Use the D-Pad or trackball to position the cursor where you want your 
text selection to begin or end.

3	 Press and hold the SHIFT key while using the D-Pad or trackball to select 
text, starting from the cursor’s location. You can deselect the text by 
releasing the SHIFT key and rolling the trackball.

4	 When finished selecting, press MENU  + C. Now you can paste (MENU 
 + V) the text in any text box on the device. Exit text mode by pressing 

DONE .
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View and Save Web Page Images
You can switch your view of a page to “image mode” which allows you to 
view and save images on a Web page.

1	 With a Web page on the screen, press MENU  and select Image 
Selection Mode (MENU  + L). You are now in “image mode”.

2	 Roll the trackball to highlight the image you want to view or save to 
your device. Note that in this mode, images (instead of hyperlinks) are 
highlighted as you roll the trackball.

3	 Press the trackball to select the image. It opens alone on the screen. 
Zoom the image by pressing the D-Pad up or down.

4	 Press and hold the trackball to open the context menu. From this menu 
you can Save Image to your Device Album, Copy Image Location or 
Send the image link via the options listed.

5	 Press DONE  to return to the Web page, still in image mode. Press 
DONE  again to exit image mode.

Web Page Layouts
You can view a Web page in a variety of layouts. To change the view, press 
MENU  and select View. Alternatively, you can toggle views using the 
shortcuts listed below. 

n	Screen-Size Layout - This is the default view, in which the page is fitted to 
the screen width. To switch to this view press MENU   and select Screen-
Size Layout [MENU  + W]. 

n	Full-Size Layout - In this view the Web page is presented in its original 
layout. So, only part of the full-size page fits in the screen.To switch to 
this view, press MENU  and select Full-Size Layout [MENU   + W]. To 
see all of the zoom options when in full-size layout select View > Zoom 
submenu.
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Mini Page
You can see an overview of the whole page so that you can navigate the 
page and select an area to zoom in on using the Mini Page tool. To switch 
to Mini Page, press [MENU  + SPACE].

	

MINI PAGE

RED RECTANGLE 
(CURRENT VIEW)

 

	 While in Mini Page: 
n Use the trackball to move the red rectangle to the area you want to view, 
then press the trackball to view that area in the main screen.  
n Scroll quickly the height or width of a page by holding down MENU  
while rolling the trackball. 
n Zoom in/out of the page by pressing the D-Pad up/down. You must be 
in Full-Size Layout view to zoom.

To navigate a Web page:
n	Use the trackball or the D-pad to move right/left or up/down. 
n	Scroll page by page by holding down MENU  while rolling the trackball 

up/down; or press  to page up,  to page down.
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Email  
FIRST
CLASS

Send an Email Message
1	 Press JUMP  to go to the Jump screen. Scroll to highlight Email, then 

press the trackball.
2	 Using D-Pad left or right, navigate to the tab containing the email 

account you wish to use.
3 	 Press MENU   to open the menu. New Message is selected by default; 

press the trackball to open the Compose screen. Alternatively, press 
MENU  + N.

4	 The text cursor is in the To field; type the name or email address of 
the person to whom you wish to send an email. If you type a name, 
the Address Book will try to pull the correct email address from your 
contact data. Add more To fields by typing a comma (,) or semicolon (;). 
Open the menu to add a CC or BCC.

5	 Scroll to the Subject field and type the subject of your email.
6	 Scroll to the message body and type your message.

   To delete text in the forward direction, press the SHIFT + DEL keys 
together. To delete the current line of text, press the ALT + DEL keys 
together.

7	 To save the message as a draft, press DONE . To send the message, 
either select the Send button at the bottom of the Compose screen, or 
press MENU  + M.

Fetch Email from External Accounts
When you register your device account, you automatically receive an email 
account that you can use immediately on either your device or the Email 
application on the Desktop Interface. Your email address is username@
tmail.com, where username is the name you selected during registration.
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In addition to the email account that came with your device, you can 
receive email from (up to) three accounts with external email providers. You 
can also check some Internet email accounts by using the Web Browser, as 
described in “Fetch Email Using Your Device’s Web Browser” on page 60.

About Tabs
You can display the email you fetch to your device from external accounts 
in separate tabs on the Browse Email screen, with each tab containing an 
Inbox and the other system folders (Saved, Drafts, Sent, Trash).

Here are some tips about using tabs:

n	 Navigate Tabs – The quickest way to navigate tab-to-tab is to press the D-
Pad left or right. You can also jump to any tab by pressing MENU  then 
selecting View [  + D]. The submenu lists all of the email accounts on 
the device. 

n	 Hide/Show “System” Tabs – You can hide or show the Welcome 
and Add Accounts tabs by pressing MENU  then opening the View 
submenu.

n	 Move a Tab – With a tab highlighted, press MENU  then select  
Move [  + O]. Use the D-Pad to position the tab where you want it, then 
press the trackball.

n	 Rename a Tab – With a tab highlighted, press MENU  then select 
Rename. Type a new tab name in the Rename Tab dialog box, then press 
DONE .

Add an External Account
The instructions that follow explain how to use your device to fetch email 
from external accounts. You can also set up accounts from the Email 
application on the Desktop Interface.

1	 Press JUMP  to go to the Jump screen. Scroll to highlight Email, then 
press the trackball.
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2	 Press MENU   then select Accounts > Add Account. Alternatively you 
can select the Add Account tab (if shown). Select a provider from the 
submenu:
n	 If you select one of the branded accounts, you will be asked to sign 

in, agree to the terms of service, and your account will be set up in its 
own tab. If successful, the last seven days of messages will be fetched 
to your device. 

n	 If you select the POP/IMAP option, you can select one of the 
providers from the list, or choose Other Pop/IMAP, and provide the 
information, described below.

n	 If you selected a named provider, the Mail Server, Port, and Protocol 
will auto-fill. Otherwise, for Mail Server, if you don’t know the name of 
your email server, your email provider will be able to tell you, or if you 
have an email account through your ISP, contact them for assistance. 
Reference the table below for samples:
Web Email Provider		  Mail Server Name
Yahoo!® Mail			   pop.mail.yahoo.com 
Mail.com			   pop1.mail.com 
Softhome.net			   mail.SoftHome.net 
Gmail				    pop.gmail.com

n	 Select Protocol from the pop-up menu. If you aren’t sure what 
protocol your email server uses, select Auto-detect (the default 
selection) or select one of the email services listed at the bottom of 
the pop-up menu.

n	 Complete the Port field. Unless your email provider has specified 
otherwise, leave the port at 110. If you selected a specific email 
service in the Protocol field, then the Port field will auto-fill correctly.

n	 Complete the Username field. The name you use to sign in to your 
account.

n	 Complete the Password field. The password you use for your account. 
3	 When complete, select Next  

4	 The Identity dialog box appears. Change the From Name/Address 
and/or the Reply-To Name/Address fields if you want. These will be 

58	 Using the Applications



used  for all messages sent from this account. When complete, select 
Next .

5	 The Email Storage dialog box appears. Select to store your account 
email in either a separate tab, or your primary account folder. Select a 
folder or create a new folder from the pop-up menu. When complete, 
select DONE .

6	 The system will attempt to sign you in to the account. You will receive 
notification if there are any sign-in problems.

Edit External Email Account
To edit an existing account, do the following while in the Email application:

1	 From the Browse Email screen, press MENU  then select Accounts > 
Edit. Select the account you want to edit from the submenu. 

2	 The Edit Account dialog box opens. Step through the dialog boxes or 
jump to a specific dialog box from the pop-up menu. In addition to the 
information you provided when you set up the account, you will see 
General and Signature categories.

3	 In the General dialog box, you can turn certain functionality on or off:

n	 Collect email from this account – This option is checked by default. 
If, at some point in the future, you want the Email application to stop 
collecting email messages from the external account, uncheck the 
box. The account information is saved.

n	 Remove retrieved email from server – This option is not checked 
by default. This means that as your messages are fetched to your 
device and Email Desktop Interface, those messages are also kept 
on your external account’s email server. If you want the messages on 
the server to be removed as they’re downloaded to your device, then 
check this box.

n	 Copy outgoing messages – You can have each message you send 
from this account automatically CC’d or BCC’d to another email 
address. Check the box and the type the email address in the text 
field.
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n	 Send new message alerts – This option is checked by default. When 
checked, after a new message arrives, you will receive a balloon alert 
and sound and see an icon in the title bar. This assumes you have 
selected a New Message Alert ringtone on the main menu’s Settings 
> General screen.

4	 In the Signature dialog box, you can change how the messages from 
your account are signed. The signature is added automatically to any 
new message.

5	 When you are finished making your edits, select DONE . To discard 
any changes you’ve made and dismiss the screen, press CANCEL .

Fetch Email Using Your Device’s Web Browser

If there is a Web interface to your email account, you can use your device’s 
Web Browser application to sign in to those accounts and check your 
email. A couple popular email Web sites are listed below:

n	 Yahoo! ®  Mail  – http://mobile.yahoo.com/home
n	 MSN Hotmail – http://mobile.msn.com/hm/folder.aspx

Press MENU  + K to open the Bookmarks screen; some sites may have 
been bookmarked for you. 

To go directly to an email Web site, do the following:

1	 Press JUMP  to go to the Jump screen. Scroll to highlight Web 
Browser, then press the trackball.

2	 Begin typing the URL for your Internet email account. Your entry will be 
inserted in the Go To dialog box automatically.

3	 Press the trackball to go to the Web site’s sign in page.
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Attach a Media File or vCard to an Email Message

You can attach up to 2 MB of files to an email message.

1	 Press JUMP  to go to the Jump screen. Scroll to highlight Email, then 
press the trackball.

2	 Press MENU  + N to open the Compose screen. Complete the To, 
Subject, and Message fields.

3	 Do one of the following to attach a photo, video, vCard, or sound:
n	 Attach Image/Video – Press  to go to your Camera albums. Roll the 

trackball to highlight an item, then press the trackball to select an 
image or video to send. You can select multiple items by holding the 
shift key while rolling the trackball. Each selected item will display a 
check mark in the corner. When you’ve finished selecting, open the 
menu and select Use Checked or press DONE .

n	 Attach Voice Recording – Press  to open the recorder. Press  
again to start recording and DONE  to stop recording. Review your 
recording then, when ready, press DONE . 

n	 Attach Song or Ringtone – Press MENU  and select Attach > Audio. 
Select a song/ringtone category from the audio selector list, then 
choose a specific song or ringtone from the pop-up menu and press 
DONE .  

n	 Attach vCard – Press MENU  and select Attach > vCard. Highlight 
the contact you want to send, then press the trackball to select it.

4	 Your email message returns to the screen, including attached items. (To 
remove an attachment, highlight it and press the DEL key.) Select the 
Send button or press MENU  + M to send.
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Address Book  

Add a Contact to the Address Book
You can store up to 2000 contacts in your Address Book and assign 50 of 
those as “favorites”.

1	 Press JUMP  to go to the Jump screen. Scroll to highlight Address 
Book, then press the trackball.

2	 Press MENU  to open the menu. New Contact is selected by default; 
press the trackball to go to the New Contact Identity screen.

3	 To create a contact, you only need to type basic “identity” information: 
a First or Last name. 

	 On this screen you can also provide a Middle name and a Nickname, as 
well as select an icon. 

4	 To select an icon, roll the trackball up to highlight , then press the 
trackball to open the icon selector. Highlight the icon you want, then 
press the trackball to select it. 
To assign a Photo Caller ID icon, select from the icon selector, 
which will open the Browse Albums screen. Then, from this screen:
n	 To select a photo already in an album, roll the trackball to highlight 

the photo you want to associate with the contact, then press the 
trackball to select it. Press DONE . 

n	 To capture a new photo, press . Press  again to capture, then DONE 
 to save the photo. Press DONE again to view the album contents. 

Select the photo. Press DONE .
A smaller version of the photo now appears on the Identity screen and 
will be used to identify that contact on incoming call notifications.

5	 When finished with the Identity screen, select DONE . You advance to 
the next New Contact screen, in which you can type or select additional 
contact information.
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6	 Scroll through the New Contact fields (Personal Info, Phone, Email, 
and so on), selecting Add or Edit to open screens in which you can 
add contact details. Set a custom ringtone for your contact in the Add 
Details dialog box for Phone.

7	 If a contact has multiple phone numbers, you can mark one of the 
numbers as Preferred for easy dialing from the Browse Contacts screen.

8	 When finished, press DONE  to save your new contact information.

Assign a Contact as a “Favorite”
You can assign 50 favorite contacts. A favorite contact is marked in the 
Browse Contacts screen with a heart . All your favorites are listed in the 
Favorites tab on the Browse Contacts screen. Your MyFaves contacts are 
automatically marked as Favorites and will be listed in the Favorites tab.

For favorite contacts, when you open their Contact Details screens, you will 
see an Activity Log tab, which lists the last 15 communications you’ve had 
with this contact. 

To assign a contact as a favorite:

1	 On the Browse Contacts screen, highlight the contact you want to be a 
favorite.

2	 Press MENU  and select Add to Favorites. Your contact will now 
appear in the Favorites tab, as well as in the All tab. If you ever want to 
unassign this contact as a favorite, highlight the contact, press MENU 

 and select Remove from Favorites. Note that in order to remove a 
MyFaves contact from the Favorites tab you must first replace it with 
another contact in the MyFaves application.

Address Book Tabs
The Browse Contacts screen now has information displayed in tabs:

n	 All tab – Displays all contacts, or a specific category of contacts that 
you’ve selected from the View submenu.

n	 Favorites tab – Displays all the contacts you’ve assigned to be favorites.
n	 Recent Calls tab – Displays the last 100 calls in the Call Log.
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n	 Online Now tab – Displays all your buddies that are online. Note that if 
you are offline for a specific IM service, then the online buddies for that 
service will not be displayed.

For more information about using tabs, read “About Tabs” on page 57.

Communicate with a Contact
From the Address Book’s Browse Contacts screen, highlight a contact, then 
press and hold the trackball. A menu opens that lists all the communication 
options available for that contact. Select the action you want to take. 
Alternatively, you can quickly dial the contacts Preferred number by 
pressing the green call button directly from the Browse Contacts screen.

You can also quickly send an email, instant message, text message, or 
place a call to a contact from a contact’s “Details” screen:

1	 Go to the Address Book and select a contact with the trackball. Their 
Contact Details screen opens.

2	 The Contact Details screen lists all the information that you have stored 
for this contact: phone numbers, email addresses, IM screen names, 
and so on.

3	 To open a communication with this contact, highlight the phone 
number or address of interest, then press the trackball to select it. A 
menu opens with relevant communication options.

4	 Select the option to send the call, open a compose screen, or an IM 
conversation.

If you go to the Recent Calls or Online Now tabs, select a call or screen 
name to open a communication with that contact.

To edit or add contact details, select the Edit button on the Contact Details 
screen.
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Import Address Book Contacts
If you have a SIM card from T‑Mobile with contact information stored on it, 
you can import that information to your device by following the instructions 
in “Import Contacts from Your SIM Card” on page 49 of this guide.

If you have existing contact information stored in a Personal Information 
Management (PIM) application, you can import that data to your Address 
Book on the device and Web. To do this, first go to your Address Book on 
the Web:

1	 Go to your desktop or laptop computer and sign in to the Desktop 
Interface (see “The Desktop Interface” on page 42).

2	 From your Jump page, click Address Book.
3	 Click Import in the Address Book sidebar. The Import page opens.
4	 The Import page includes step-by-step instructions for completing the 

import process. The following file types (exported formats) can be 
imported: Microsoft Outlook for PC (.txt file), Microsoft Outlook Express 
for Mac (.txt file), Microsoft Entourage for Mac (.txt file), Palm Desktop 
for PC (.txt/.tab file), Palm Desktop for Mac (.txt/.tab file).

5	 After you click the Import button, your contacts are imported to your 
Web Address Book then sent to your device via the network. Make sure 
your device has a wireless connection; then, after two to three minutes, 
check your device to confirm that your new contacts have arrived.

Set and Send “My vCard”

You can set one of your contacts to be “you”, so that you can send “My 
vCard” to others easily.

1	 Press JUMP  to go to the Jump screen. Scroll to highlight Address 
Book, then press the trackball.

2	 Scroll to highlight the contact you want to set as “you”, then press MENU 
 and select vCard > Set as My vCard. On the Browse Contacts screen, 

you will now see a  icon next to your name.
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3	 To send your vCard, from the Browse Contacts screen, press MENU 
 and select vCard > Send My vCard via > Email [MENU  + M], Text, 

MMS, or Bluetooth [MENU  + Y]. For Email, Text and MMS, a compose 
screen opens. For Bluetooth, a dialog opens that allows you to select 
the receiving device.

4	 To change or remove the “My vCard” setting, first press MENU  
and select vCard > Clear My vCard. To set a different contact as “My 
vCard”, highlight the contact, then press MENU  and select vCard > 
Set as My vCard.

Send any Contact’s vCard
1	 Press JUMP  to go to the Jump screen. Scroll to highlight Address 

Book, then press the trackball.
2	 Scroll to highlight the contact whose vCard you want to send, then 

press MENU  and select vCard > Send Contact’s vCard via > Email, 
Text, MMS, or Bluetooth. For Email, MMS, and Text, a compose screen 
opens. For Bluetooth, a dialog opens that allows you to select the 
receiving device.

Calendar  

Add an Event to Calendar
You can create and store up to 1000 events in your Calendar. 

1	 Press JUMP  to go to the Jump screen. Scroll to highlight Organizer, then 
press the trackball to open the second-level ring of applications. Highlight 
Calendar, then press the trackball.

2	 Press MENU  + N to open an Event Details screen.
3	 Name your event, type a location, assign a duration, add reminders, 

repetitions, and notes as applicable.
4	 Press DONE  to save the event. It will now appear on your Upcoming 

(if it’s scheduled within the next seven days), Daily, Week, or Month 
views.
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5	 To view your schedule, select one of the “Views” from the menu. Each 
view has a keyboard shortcut:
n	 Upcoming 	 MENU  + 0
n	 Day		  MENU  + 9
n	 Week		  MENU  + 8
n	 Month		  MENU  + 7
n	 Year		  MENU  + 6
n	 Trash 		  MENU  + T

Notes  

Create a Note
You can create and store up to 50 notes. Each note can be up to 8000 
characters, which is about four pages in a paperback.

1	 Press JUMP  to go to the Jump screen. Scroll to highlight Organizer, 
then press the trackball to open the second-level ring of applications. 
Highlight Notes, then press the trackball.

2	 Press MENU  + N to open a blank note. Type your note; it is saved as 
soon as you type it. 

3	 Press the trackball to fold your note; press again to unfold. Notes must 
be unfolded before you can edit them. 

Send a Note via Email
1	 Press JUMP  to go to the Jump screen. Scroll to highlight Planning, 

then press the trackball to open the second-level ring of applications. 
Select Notes.

2	 Create a new note or highlight an existing note.
3	 Press MENU  and select Send Note or press MENU  + M. A compose 

screen opens with the note in the message body; complete the message 
and Send.
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To Do  

Add a Task
You can create and store up to 50 tasks. 
1	 Press JUMP  to go to the Jump screen. Scroll to highlight Planning, 

then press the trackball to open the second-level ring of applications. 
Highlight To Do, then press the trackball.

2	 Press MENU  + N to open a blank task screen. Create your task.
3	 Press DONE  to save the task.

Camera  
Your device comes with a built-in 3.2 megapixel photo/video camera with 
built-in flash and auto focus You can store up to 1.75 MB of photos on your 
device’s internal memory. You can store more photos plus videos on your 
microSD card. The number you can store will depend on the capacity of 
the card and the size of the photos (Small, Medium, or Large) and length of 
the videos. Remember that you might be sharing the card’s capacity with 
sound files as well.

 Before you capture a photo or video, be sure your camera lens is clean!
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Albums
Albums are used to organize all photos/videos that are stored both on 
the device’s internal memory (Device Album) and on the memory card 
(Memory Card Album). 

n	 To access your album(s), press JUMP  to go to the Jump screen. Scroll 
to highlight Camera, then press the trackball. Scroll to highlight the 
album you want to view, then press the trackball. If you do not have a 
memory card installed, the device album will be open by default.

n	 To add a new album, from within the camera application press MENU 
 and select New Album. You can also use the shortcut MENU   + N. 

Enter a name for the new album and  press DONE . 
n	 To select all items in an album, open or highlight the album, then press 

MENU  and select Edit > Check All in Album, or press MENU  + A. To 
uncheck, select Edit > Uncheck All or press MENU  + U.

n	 To move an item to from one album to another, first select the item or 
items,  then press MENU  and select Move Item. You can also use 
the shortcut MENU  + O. Select the album, you want to relocate the 
item(s) to. 

n	 To edit a photo, open the album where the photo is located and 
highlight the photo. Press MENU  and select Edit. A secondary menu 
opens giving you the option to rotate, crop, or reduce the photo and 
edit the item info. Note that for videos, you can only edit the item info.

n	 For information on how to send an album item(s), read “Send Media 
Files via Bluetooth, Email or MMS Message” on page 71.

Take a Photo
1	 Press JUMP  to go to the Jump screen. Scroll to highlight Camera, then 

press the trackball.
2	 Press MENU   and select Capture or simply press the right shoulder 

button . The screen now acts as the “viewfinder”. Note that you can 
also press the right shoulder button directly from the Jump screen to 
enter the viewfinder.

	 Using the Applications	 69



3	 To change the quality and resolution of your photos, press MENU  and 
select Photo Settings or select the Settings button. 
n	 Resolution - Select from 2048 x 1536 (3MP), 1600 x 1200 (2MP), 1280 

x 960, 800 x 600, 640 x 480. 
n	 JPEG Quality - Select from High, Medium, Low.
n	 White Balance - Adjust to reflect the light source. Select from Auto, 

Daylight, Cloudy, Fluorescent, and Incandescent. 
n	 Effects - Select from Off, B/W, Sepia or Negative.
n	 Geotagging -  Select to turn on geotagging and tag your photos with  

location coordinate information.
n	 Turn photo tooltips on  -  Select to display tips.

 Larger JPEG Quality and Resolution values increase the quality of 
your photo but require more storage space. The number of pictures 
remaining is shown in the upper right of the screen. 

4	 You can change your flash or auto focus settings by using the buttons 
on the left of the screen, or adjust exposure by using the D-pad left/
right.

	 Flash Settings - Auto Flash, On, Off
	 Focus Settings - Auto Focus, Macro, Infinity
5	 Use the DISP button to hide or show the information on the screen.
6	 By default, the photo will be saved to the Memory Card Album. To save 

to your device, press MENU  and select Capture to. From the submenu 
select Device Album, or another album you created on the memory 
card.

7	 When you’re ready to take your photo, first press the right shoulder 
button  half-way down to focus. Once the focus box turns green, press 
the button the rest of the way to capture the photo. If the focus box turns 
red, release the button and try focusing again. You can also use the 
trackball to select the capture photo button      .

8	 The photo preview appears on the display. You can:
n	 Press CANCEL  to discard it; or,
n	 Press DONE  to save it to the album you’ve selected. If you do 

nothing, the photo will be automatically saved after a few seconds.
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Once the preview has disappeared, you can select      to send the photo 
via Email, Audio Postcard, Bluetooth and MMS.

9	 To return to the album, select  or press DONE .

Capture Video
Videos can only be stored on your memory card, so be sure you have a 
card inserted!

1	 Press JUMP  to go to the Jump screen. Scroll to highlight Camera, then 
press the trackball.

2	 Press MENU  and select Capture, or simply press the right shoulder 
button . The screen now acts as the “viewfinder”.

3	 Make sure you are in “Video mode”. If you are in “Photo mode”, then 
select the mode button  to switch to “Video mode”.

4	 To change the quality setting of your video, press MENU  and select 
VideoSettings or select the Settings button. If you plan on sharing your 
videos via email or MMS, select the Low Quality video setting to ensure 
that your videos don’t exceed email or MMS size limits.

5	 When you’re ready to start your video, press the right shoulder button  
or use the trackball to select start recording button. During recording, 
you will see a red dot at the top of the screen.

6	 To pause the recording, select the pause button. To end the recording, 
select the stop button .

7	 Once you select the stop button, the video is saved to the specified 
album on your memory card. At this point you can select the send 
button  to send the video via Email, Bluetooth, and MMS.

8	 To return to the Browse Albums screen, select  or press DONE .

Send Media Files via Bluetooth, Email or MMS Message
To send photos or videos, select the items you want to send from the 
Browse Album screen, then press MENU  and select Send # Checked via 
> Email [MENU  + M], Audio Postcard, MMS, or Bluetooth. For Email and 
MMS, a compose screen opens. For Audio Postcard, a select picture frame 
screen opens. For Bluetooth, a dialog opens that allows you to select the 
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receiving Bluetooth device. The recipient of the file(s) will receive an alert 
asking them to approve the Bluetooth transfer before it is made.

You can also attach one or more photos/videos while composing an email 
message or a multimedia message. For instructions, read “Attach a Media 
File or vCard to an Email Message” on page 62, and “Send a Multimedia 
Message” on page 50.

Use Photo for Caller ID or Key Guard Background
You can assign the photos you’ve saved in one of your photo albums as a 
Caller ID or a key guard background image.

To assign a photo as a Caller ID:

Follow the instructions in “Add a Contact to the Address Book”, step 4, on 
page 62.

To assign a photo as a key guard background image:

1	 Press  JUMP  to go to the Jump screen, then press MENU  and select 
Settings > Key Guard & Security.

2	 Press the trackball with the Select Image pop-up highlighted. Select  
to go to your Camera Albums.

3	 Select the photo you want to use as the key guard background by high-
lighting it then pressing the trackball. 

4	 Press DONE  to make the assignment, then press DONE  again to 
dismiss the Key Guard & Security screen.
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Media Player  
Use the Media Player media player to play audio and video files that you 
have stored on your microSD card. You can use a memory card of any 
capacity. Remember that you might be sharing the card’s capacity with 
Camera photos and videos.

  The media player will play 3GP and MP4 (simple profile) video files, 
and MP3, M4A, WMA, WAV, AAC, AMR, MIDI, XMF, AIF, RMF audio files; 
it will not play audio files that are not listed above or any files with DRM 
protections. 

Copy Music or Video to the Memory Card

Before you can copy any songs or videos to your memory card, you must 
insert a card into the microSD card slot on your device. For instructions, 
read “Insert and Remove the Memory Card” on page 10. 

Once your card is installed, do the following:

1	 Connect your device to your computer with the USB cable provided in 
the box. Read more in “Charge the Battery” on page 12.

2	 On your computer, find the mounted USB drive and open it.
3	 You should see a folder at the top-level named “Music”. If you do not 

see this folder, then create it. If you are copying a video file, create a 
folder named “Video”.

4	 You’re ready to copy audio or video files to the memory card. In the 
Music folder, it’s best if you organize your songs in sub-folders. For 
example, you could create one folder for each album or artist. Use sub-
folders in the Video folder too if that helps you organize the files.

5	 Copy audio or video files from your computer’s hard drive to your 
device’s mounted USB drive, in the folders under “Music” or “Video”, 
as appropriate.

6	 When finished copying, close the USB drive window and “unmount” the 
drive as required by your computer. Remove the USB cable from your 
device and computer.
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Play Music or Video Using the Media Player
Listen to your music and videos using the device speaker, stereo 
headphones with a 3.5mm jack (including those provided in the box) or a 
stereo Bluetooth device. 

1	 Press JUMP  to go to the Jump screen. Scroll to highlight Media 
Player, then press the trackball.

2	 The Browse Media screen appears. Your music and videos are 
organized into categories with the number of items in each shown in 
parentheses. (Files are categorized automatically, based on information 
contained in the file itself.)

3	 Select a listening device by pressing MENU  and selecting Listen via. 
From the submenu, select your preferred method of listening. If you 
select a Bluetooth stereo headset, a dialog will open so you can select 
the receiving Bluetooth device.

4	 Scroll to highlight a category, then press the trackball to “drill down” to 
the next level. Here you might see songs/videos or more categories. 
At any level of the Browse Library screen, simply select the category or 
item you want to play, and it will be added to the “Play Queue” (all the 
items that are waiting to be played). You can also use the shortcuts:
n	 MENU  + P – Plays selection (interrupts currently-playing item).
n	 MENU  + Q – Queues selection (waits its turn in the list to play).
The progress of the item currently playing is shown at the top of the 
screen.

5	 Items playing in a list will not repeat, but you can change this setting 
by pressing MENU   then selecting Shuffle and Repeat. Choose from 
Shuffle, Repeat, Repeat 1, or No Repeat.

6	 To control play from anywhere on your device, press  JUMP  + DONE  
and the mini media player will open. Read more in “Mini Media Player 
Controls” on page 25.
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Streaming Video
You can now stream videos from popular Internet sites. 

1	 Press JUMP  to go to the Jump screen. Scroll to highlight Web 
Browser, then press the trackball.

2	 Type the address of the Web page containing videos you wish to view. 
3	 Roll the trackball to the picture or link of the video and then press the 

trackball to select the video to display. The device will fetch the stream 
and perform buffering prior to displaying the video.

Listen Using Stereo Bluetooth Headset
You can use a Bluetooth stereo device to listen to music or video. To pair 
and set your headset for use with the Media Player, read “Bluetooth Hands-
Free Headset or Car Kit” on page 27.

Create a Playlist
You can create as many playlists as you wish and edit them at any time. 
Here’s how:

1	 From the Browse Library screen, select one of the top-level categories, 
then find a song, video, artist, album, genre, or composer you want in a 
playlist. 

2	 With the song, video, artist, album, genre, or composer highlighted, 
press MENU  and select Add to Playlist > New Playlist.

3	 Give your new playlist a name in the dialog box that opens. Press DONE 
 to save the playlist. 

Now your newly-created playlist will be included in the Playlists category on 
the Browse Library screen. 

n	 To add songs to this or any playlist, highlight an item or category, press 
MENU   and select Add to Playlist > “Playlist Name”.

n	 To remove an item from an existing playlist, open the playlist, then 
highlight the item. Press MENU   and select Remove from Playlist (MENU 

 + ). 
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Download Catalog 

Download Items from the Catalog
Download ringtones, applications, games, and themes from the Catalog! 
You’ll find that browsing the Catalog and purchasing items is easy and fun:

1	 Press JUMP  to go to the Jump screen. Scroll to highlight Download 
Catalog, then press the trackball.

2	 Wait while the latest Catalog contents load. (If you leave the Catalog 
while the contents are loading, you’ll see a marquee notification in the 
title bar once all items are loaded.)

3	 Use the trackball to scroll through the Catalog categories. The 
categories are organized like the Jump screen in a “ring” on the left, 
with each category’s splash screen on the right. Highlight, then press 
the trackball to open a category’s Browse Items screen.

   If you know the name of the item you’re interested in, press MENU  + F 
to open the Find dialog box. Type the name of the item then select Find. 
Matches will appear; select the item of interest to open its Item Details 
screen.

4	 Individual items are grouped into folders. Highlight a folder, then press 
the trackball to open a folder’s items. Once you find an item you’re 
interested in, select the item to open its Item Details screen.

5	 To listen to a brief sample of a ringtone or view sample screenshots of an 
application or theme before you purchase it, select the Preview button. 
Select Purchase to step through the simple on-screen purchase process.

6	 Once purchased, your item will be downloaded to your device, network 
connectivity permitting. Download time varies according to the size of 
the application. You’ll be notified with the Ready to Install dialog when 
your item is ready to be installed. Select Install to install immediately 
or select Install Later to add the item to your Downloads list, where 
you can find it and install it whenever you like (see the next section, 
“Manage Your Downloaded Items”). 
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7	 If your item is not delivered immediately, you can check the download 
process from the Downloads screen, described below.

Manage Your Downloaded Items
To install or remove a downloaded item; check the download status of a 
purchased item; or view a list of all the downloads you have made through 
the Catalog (including details such as price, subscription term, upgrade 
information), go to the Downloads screen:

1	 Press JUMP  to go to the Jump screen. Scroll to highlight Download 
Catalog, then press the trackball.

2	 Scroll to Downloads, then press the trackball to open the Downloads 
screen.

3	 All your downloads are listed on this screen, organized into folders by 
categories. Highlight a folder, then press the trackball to reveal the 
items within. 

4	 Items currently being downloaded or waiting to be installed are 
shown in italic with the “transmitting” icon   . Items that have been 
uninstalled are shown in italic.

5.	 To install an item, select it using the trackball, then select Install from 
the Ready to Install dialog. 

6	 To view item details, highlight the item then press the trackball. To discard 
any highlighted item permanently, press MENU  then select Discard.
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Instant Messaging 
You can use all of the instant messaging applications at the same time!

Sign On
1	 Press JUMP  to go to the Jump screen. Scroll to highlight Instant 

Messaging, then press the trackball to open the second-level ring of 
applications. Highlight the IM application of your choice, then press the 
trackball. The Sign On screen appears.

2	 Type your username and password (passwords are case-sensitive), then 
select the Sign On button.

3	 Your list of friends appears. You are ready to send an instant message.

Send an Instant Message
1	 Press JUMP  to go to the Jump screen. Scroll to highlight Instant 

Messaging, then press the trackball to open the second-level ring of 
applications. Select the IM application of your choice.

2	 Sign on with your username and password; the screen listing all your IM 
friends’ usernames displays.

3	 To start a conversation with a friend on your list, scroll to highlight the 
friend’s username, then press the trackball to start a conversation.

4	 Type your message. When ready, press the Return key to send.

Switch Between IM Conversations
You can have up to 10 IM conversations open at the same time. You can 
switch between conversations quickly by doing one of the following:

n	 From Menu – Press MENU  + D to open the IM Conversations 
submenu, which lists all your open conversations. Scroll to highlight the 
conversation you want to open, then press the trackball.

n	 Using Conversation Number – Each open IM conversation has a 
number (0-9), which is displayed in the IM Conversations submenu, as 
well as on the screen displaying your list of friends. From any screen 
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in IM, including the IM splash screen, you can quickly switch between 
conversations by pressing MENU  + the IM conversation number.

n	 From Friends List Screen – On the screen listing all your friends’ 
usernames, scroll to highlight the conversation to which you want to 
switch, then press the trackball.
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Keyboard Shortcuts
Call a speed dial number	 Press and hold speed dial # on keyboard while  
	 in Phone or on Jump screen.

Redial last number	 Press JUMP , , .

Answer an incoming call	 Press trackball or .

Ignore incoming call (call forwards)	 Press .

Hang up active call	 Press .

Mute your device when ringing  	 Press any key, except .

Create a new note, message, event,   
task, to do, or contact	 Press MENU  + N.

Insert Unicode character	 Press SYM key.

Discard item	 Highlight item, press MENU  + CANCEL .

Send a composed message	 Press MENU  + M. 

Open latest unread message	 Press JUMP  + 0. 

Delete all text in a single line  	 Press ALT + DEL.

Put device in key guard mode	 Press and hold DONE  two seconds.

Unlock device  	 Press MENU  + DONE . 

Power device on/off  	 Press and hold  for three seconds.  
	 Press twice to power off.

Open Sound Controls	  Press MENU  + DONE .

Open mini music player	  Press JUMP  + DONE .

Open Quick Jump menu	 Press JUMP  + CANCEL .

Scroll page-by-page  	 Hold MENU  and roll trackball; or, 
	 press  to page up,  to page down.

Find an item across apps	 Press JUMP  + F.
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Troubleshooting
How do I know when my account is ready to register for data serv-
ices?
Once your account is ready for you to register for data services, you will 
see a “Welcome” message on your screen. If the Welcome message 
doesn’t appear on your device within 48 hours, contact T‑Mobile Customer 
Care department.

In order to comply with airline regulations, how can I temporarily dis-
able wireless connectivity when traveling?
Remember to switch to “Airplane Mode” during aircraft takeoff and 
landing. To turn off wireless connectivity (to comply with FAA regulations) 
follow these instructions:

1	 From the Jump screen, press MENU   , and select Airplane Mode > 
Turn Wireless Off.

2	 Your device is now offline. Confirm offline status by looking at the title 
bar; the radio icon and “OFF” should blink alternately.

Even without wireless connectivity, you can still access the device 
applications and read email messages that have already been downloaded. 
However, you will not be able to send or receive messages until you enable 
wireless connectivity again.

How can I protect my device from damage?
The best way to protect your device is to carry it with the display closed and 
in the protective sleeve supplied in the box. You risk damaging your device 
if you do not protect the display. Also, water–even in small amounts or in 
the form of steam–can seriously damage your device and charger, so keep 
your device dry and away from potential water sources.
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I needed to remove my battery, so I did. After I put the battery back in 
my device, it powered up, but all my messages and other data were 
gone. Is it all gone for good?
No, all your data is regularly saved in an ongoing basis to the Danger 
service so it is safe. If you wait a few minutes, all your data will be restored 
to your device. (Note, however, that any data you entered or modified 
between the last save to the Danger service and when you removed the 
battery will be lost.)

Chances are you removed the battery before powering off your device. Every 
time you power off your device, your data is saved to the device’s internal 
flash memory. However, if you remove your battery before shutting down, 
your data will not be saved to flash. It is recommended that you always power 
off your device before removing the battery!

How can I improve radio reception when I’m in a “fringe” coverage 
area?
Try the following to improve radio reception:

n	 Use the hands-free headset and position the phone away from your body.
n	 Walk to a window if you are indoors.
n	 Step outside of buildings that have high metal, concrete, or earthen 

content, because they may absorb radio signals.
n	 Step away from metallic windows because they absorb RF energy.
n	 Go to the highest spot possible to make the call.
n	 Step away from computers or electronic equipment.
n	 If you are in a car, first park, then try the call from outside the car.
n	 If you are near or directly under a cellular/PCS radio tower, walk at least 

one block away.

My device has not connected to the service for quite a while. Is there 
anything I can do myself before calling Customer Care?
Yes, try powering your device off and on. After your device boots, you’ll 
know you’ve connected to the service when you see the  in the title bar 
again.

82	 Troubleshooting



What can I do when the device is frozen?
Remove the battery, wait for one minute or so, then put the battery back in 
the device.

What Web browsers do you support on the Desktop Interface?
Web browsers IE 5+ are supported on both the Windows and Macintosh 
operating systems, as well as Firefox and Safari.

Why do the Web pages I open using the device’s Web Browser 
application appear different from the pages I open on my desktop 
computer?
The Web pages displayed on your device have been reformatted so they 
are easier to read on a small display. The same or similar information 
displays; it’s just laid out on the screen so that it’s easier to view on your 
device.

What are the requirements for getting my POP or IMAP email 
accounts to appear on my device? 
To fetch messages from an email account, you must gather the following 
information:

n	 Name of the remote email server (e.g., mail.example.com).
n	 Protocol used by the remote email server (e.g., POP, IMAP).
n	 Your username on the remote email server. (For example, if your email 

address is joe@example.com, then your username is “joe”.)
n	 Your password on the remote email server. This is the same password 

you use to open the remote email directly.
Most Internet Service Providers and University email systems work with 
the POP3 protocol. If you are not sure of the protocol, use the Auto-detect 
setting, or you can call or email your remote service and ask what protocol 
they support. The remote service operators can also tell you the name of 
the remote email server.
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Once you have all this information, set up your external account by 
following the instructions in “Fetch Email from External Accounts” on page 
56 of this guide. Once set up, your remote email account will be checked 
periodically and a copy of all new, unread messages will be placed in the 
Email mailbox on your device.

How secure is my account data on the Desktop Interface? There may 
be sensitive information stored in contact information (for example, 
credit card numbers) that must be secure!
Information in your account is stored on servers in a data center with 
enhanced security and firewall features. Please refer to the T‑Mobile Privacy 
Policy and the Danger® Service Privacy Notice for more information.

What should I do if I need a replacement part for my device or if I need 
to have my device repaired? 
Contact T‑Mobile Customer Care department for support.

How can I clean my device screen?
The screen on your device is coated with a protective layer of 
polycarbonate. You can safely use warm soapy water, denatured alcohol, 
or isopropyl alcohol to remove dirt and smudges from your screen. Be sure 
to use a very soft cotton cloth, such as an old t-shirt, to prevent scratching 
when wiping the screen.

How do I report a lost device?
Call T‑Mobile Customer Care department to report the lost device as soon 
as possible! T‑Mobile will disable your lost device and your existing data 
will remain stored on the service, assuming no one has tampered with the 
data since you lost the device. When you receive your new device, your 
account data will be downloaded to it automatically after you sign in with 
your existing username and password.
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The device is not charging when I connect it to a personal computer 
using the USB cable. What’s wrong?
Some personal computers are not able to charge your device using the 
USB cable. If this is the case with your computer, when you attach your 
device to the computer, you will see an alert on the device telling you that 
you are receiving a USB charge that is too low for charging your device. 
Instead, use the power adapter included in the box for charging. 

Why can’t I use the Location Base Service (LBS)?
Confirm that the LBS is not set to off. Also, note that the LBS will not 
function if the device is in ‘Airplane Mode’. You cannot use the Location 
Based Service (LBS) when you are underground or in a building. The LBS 
may be slow or may not function properly when surrounded by obstacles, 
or buildings, or when the LBS antenna is covered by your hand. The LBS 
antenna is located by the D-Pad. 
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Handling and Safety 
Precautions
The Sidekick is a mobile computing device that may break if dropped, 
subjected to severe shock, or exposed to water. Please handle the device 
carefully and read the precautions listed below. These precautions provide 
essential information for the safe handling of the product and for the 
protection of the users and others from possible harm.

! During a call, the sound level on your device may vary, depending on 
how you are routing the sound. Keep the volume at a moderate level to 
prevent damage to your hearing, and be careful not to switch accidentally 
to speakerphone (by pressing the right shoulder button) while the phone is 
against your ear.

Battery Handling
n	 Your device uses a removable lithium-ion battery. Lithium-ion batteries 

are recyclable. Never dispose of the battery or the unit by incineration or 
ordinary waste. 

n	 Always turn off your device before removing the battery.
n	 Never attempt to disassemble or modify the battery. 
n	 Never touch any fluid that may leak from the removable battery, because 

doing so may result in injury to the skin or eyes.
n	 Never drop your device or subject it to severe shock. This may cause the 

removable battery to leak, ignite, and/or rupture. Always immediately 
remove your device from the vicinity of any open flame in the event the 
built-in battery leaks or emits an unusual odor. 
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Device Handling and Use
n	 Never attempt to disassemble, repair, or modify your device. Such action 

may result in bodily injury, or damage to the unit or other property.
n	 Never touch liquid that might leak from a broken liquid crystal display 

(LCD), because doing so may cause a skin rash.
n	 Keep the volume at a moderate level to avoid damage to your hearing.
n	 Never dispose of your device with ordinary waste. 
n	 Never allow infants, small children, or animals within reach of your device.
n	 Never play the CD-ROM containing the Reference Guide (included in the 

box) on an audio CD player. Doing so might result in a loud noise that 
could damage your ears or speakers.

n	 Switch off your device or put your device in “Airplane Mode” when in 
an aircraft. The use of the device in an aircraft may be dangerous to 
the operation of the aircraft, disrupt the cellular network, and is illegal. 
Failure to observe this instruction may lead to suspension or denial of 
cellular telephone services to the offender, or legal action, or both.

n	 Check with your doctor if you have a pacemaker or hearing aid to 
make sure you can safely use the device’s cellular and Bluetooth radio 
frequencies.

n	 Persons with pacemakers:
-	 Should always keep the phone more than six inches from their 

pacemaker.
-	 Should not carry the phone in a breast pocket.
-	 Should use the ear opposite the pacemaker to minimize the potential 

for interference.
-	 If you have any reason to suspect that interference is taking place, turn 

your phone off immediately.
n	 Your phone contains exposed magnets, which may cause damage 

to credit cards, magnetic ID cards, and other magnetically encoded 
materials. Do not place these or other items that are sensitive to 
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magnetic fields near the exposed magnets. For example, do not place 
your phone in the same pocket as your credit card or hotel key.

n	 Never attempt to dry the device using a microwave oven.
n	 Using this device for long periods of time (e.g., playing games) may 

cause the device and the battery charger to get warm. If you feel the 
device or the battery charger to get warm. If you feel the device or the 
battery charger is too warm, avoid sustained contact with exposed skin 
otherwise this might cause discomfort, or eventually a burn.

n	 The Health Industry Manufacturers Association recommends that a 
minimum separation of six (6”) inches (15.24 centimeters) be maintained 
between the phone and a pacemaker to avoid potential interference 
with the pacemaker. These recommendations are consistent with the 
independent research by and recommendations of Wireless Technology 
Research.

n	 Certain locations (e.g., hospitals) may restrict the use of any device that 
emits low-level RF energy. Always comply with posted prohibitions of the 
use of RF-emitting devices.

n	 Do not use the device when at a refuelling station.
n	 Observe restrictions on the use of radio equipment in fuel depots, 

chemical plants, or where blasting operations are in progress.
n	 It is advised that the device not be used by a driver while the vehicle is 

moving, except in an emergency. Speak only into a fixed, neck-slung or 
clipped-on microphone, or Bluetooth headset when it would not distract 
your attention from the road.

n	 Never allow any metallic objects (e.g., staples, paper clips) to become 
inserted into your device, as this could result in the generation of excess 
heat or fire. 

n	 Never use or store your device in the following locations: 
-	 Anywhere it may be exposed to water (e.g., bathroom, sauna)
-	 Conditions of high humidity (e.g., rain or fog)
-	 Conditions of extreme high temperatures (e.g., near fire, in a sealed 

car)
-	 In direct sunlight
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-	 Locations or sites subject to strong vibration
n	 Using this device for long periods of time (e.g., playing games) may harm 

your hands or eyes. For your health and safety, take a 10-15 minute break 
every hour. 

n	 If you have experienced seizures or blackouts that are caused by 
watching flashing lights, consult a doctor before using this device.

n	 Use your device in areas with the following ambient environmental condition:
-	 Normal operation: 0ºC to 40ºC (32ºF to 104ºF), with humidity of 30% to 80%

Battery Charger Handling
n	 The device is intended for use when supplied with power from the battery 

charger included in the box with your device, or via a USB cable to an 
approved USB host. Other usage will invalidate any approval given to this 
device and may be dangerous. 

n	 Charge the device within the temperature range of 5 to 35 degrees 
Celsius, or 41 to 95 degrees Fahrenheit, for the fastest charging time.

n	 Never place the battery charger on any surface that can be marred by 
exposure to heat; always place the battery charger on a heat-insulating 
surface. 

n	 Never use a battery charger that has received a sharp blow, been 
dropped, thrown from a speeding vehicle, or is otherwise damaged; 
doing so may damage your device.

n	 Never place the battery charger adjacent to any heat source.
n	 Never leave the battery charger close to an open container of liquids.
n	 Never use a worn or damaged battery charger cable or plug, or a worn or 

damaged extension cord or plug.
n	 When traveling abroad, never plug the battery charger into a power 

source that does not correspond to both the voltage and frequency 
specified on the charger.

n	 Always confirm that the battery charger plug has been fully inserted into the 
receptacle to ensure a secure electrical connection.

n	 In the event of any unusual odor or smoke, always immediately 
disconnect the battery charger from the device and the power outlet, 
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then power off the device.
n	 It is normal for the battery charger to become warm when charging. 

Disconnect the battery charger from the outlet when not in use.
n	 Never attempt to disassemble or repair an battery charger, power supply 

cables, or plugs, because doing so exposes you to electric shock.

CAUTION 
IMPORTANT SAFETY INSTRUCTIONS. SAVE THESE INSTRUCTIONS 
DANGER   TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, 
CAREFULLY FOLLOW THESE INSTRUCTIONS. 

FOR CONNECTION TO A SUPPLY NOT IN THE UNITED STATES, USE AN 
ATTACHMENT PLUG ADAPTER OF THE PROPER CONFIGURATION FOR 
THE POWER OUTLET.

!  RISK OF EXPLOSION IF BATTERY IS REPLACED BY AN INCORRECT 
TYPE. DISPOSE OF USED BATTERIES ACCORDING TO THE FOLLOWING 
INSTRUCTIONS:

BATTERY DISPOSAL   THIS PRODUCT CONTAINS A LITHIUM-ION 
BATTERY. THIS BATTERY MUST BE DISPOSED OF PROPERLY. CONTACT 
LOCAL AGENCIES FOR INFORMATION ON RECYCLING AND DISPOSAL 
OPTIONS IN YOUR AREA.
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Regulatory and Compliance 
Information
FCC Notice
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may cause harmful interference 
to radio communications. However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or television reception, which 
can be determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

n	 Reorient or relocate the receiving antenna.

n	 Increase the separation between the equipment and receiver.

n	 Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

n	 Consult the dealer or an experienced radio/TV technician for help.

Modifications not expressly approved by the manufacturer could void the user’s authority to operate the 
equipment. This transmitter must not be co-located or operated in conjunction with any other antenna or 
transmitter.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
(1) this device may not cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.

IC Notice
This class B digital apparatus complies with Canadian ICES-003.

Cet appareil numerique de la classe B est conforme a la norme NMB-003 du Canada.

This device complies with RSS-Gen of IC Rules. Operation is subject to the following two conditions: 
(1) this device may not cause interference, and (2) this device must accept any interference, including 
interference that may cause undesired operation of this device.
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Exposure to Radio Frequency (RF) Signals
THIS MODEL DEVICE MEETS THE GOVERNMENT’S REQUIREMENTS FOR EXPOSURE TO RADIO WAVES.

Your wireless device is a radio transmitter and receiver. It is designed and manufactured not to exceed 
the emission limits for exposure to radio frequency (RF) energy set by the Federal Communications 
Commission of the U.S. Government and Industry Canada of the Canadian Government. These limits are 
part of comprehensive guidelines and establish permitted levels of RF energy for the general population. 
The guidelines are based on standards that were developed by independent scientific organizations 
through periodic and thorough evaluation of scientific studies. The standards include a substantial safety 
margin designed to assure the safety of all persons, regardless of age and health.

The exposure standard for wireless mobile phones employs a unit of measurement known as the Specific 
Absorption Rate, or SAR. 

The available scientific evidence does not show that any health problems are associated with using low 
power wireless devices. There is no proof, however, that these low power wireless devices are absolutely 
safe. Low power Wireless devices emit low levels of radio frequency energy (RF) in the microwave range 
while being used.  Whereas high levels of RF can produce health effects (by heating tissue), exposure to 
low-level RF that does not produce heating effects causes no known adverse health effects. Many studies 
of low-level RF exposures have not found any biological effects. Some studies have suggested that some 
biological effects might occur, but such findings have not been confirmed by additional research. In the 
United States and Canada, the SAR limit for mobile devices used by the public is 1.6 watts/kg (W/kg) 
averaged over one gram of tissue. The FCC has granted an Equipment Authorization for this wireless 
device with all reported SAR levels evaluated as in compliance with the FCC RF emission guidelines. SAR 
information for this device is on file with the FCC and can be found under the Display Grant section of 
http://www.fcc.gov/oet/fccid after searching on FCC ID: APYNAR0065 for the PV300 model (850/900/17
00/1800/1900/2100 MHz).

 For body-worn operation, to maintain compliance with FCC RF exposure guidelines and IC RF 
exposure rules, keep the Sidekick at least 5/8 inch (15 mm) away from the body, and only use the 
carrying cases, belt clips, or holders that do not have metal parts and that maintain at least 5/8 inch 
(15mm) separation between the Sidekick and the body. When carrying the device on your person, it 
is recommended to turn the screen display in toward the body in order to minimize RF exposure and 
maximize antenna efficiency.

Hearing Aid Compatibility with Mobile Phones
When some mobile phones are used near some hearing devices (hearing aids and cochlear implants), 
users may detect a buzzing, humming, or whining noise. Some hearing devices are more immune than 
others to this interference noise, and phones also vary in the amount of interference they generate.

The wireless telephone industry has developed ratings for some of their mobile phones, to assist hearing 
device users in finding phones that may be compatible with their hearing devices. Not all phones have 
been rated. Phones that are rated have the rating on their box or a label on the box.

The ratings are not guarantees. Results will vary depending on the user’s hearing device and hearing 
loss. If your hearing device happens to be vulnerable to interference, you may not be able to use a rated 
phone successfully. Trying out the phone with your hearing device is the best way to evaluate it for your 
personal needs.
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M-Ratings: Phones rated M3 or M4 meet FCC requirements and are likely to generate less interference to 
hearing devices than phones that are not labeled. M4 is the better/higher of the two ratings.

T-Ratings: Phones rated T3 or T4 meet FCC requirements and are likely to be more usable with a hearing 
device’s telecoil (“T Switch” or “Telephone Switch”) than unrated phones. T4 is the better/higher of the 
two ratings. (Note that not all hearing devices have telecoils in them.)

Hearing devices may also be measured for immunity to this type of interference. Your hearing device 
manufacturer or hearing health professional may help you find results for your hearing device. The more 
immune your hearing aid is, the less likely you are to experience interference noise from mobile phones.

Regulatory Compliance Information for Europe

EU Declaration of Conformity
Hereby, Sharp Corporation, declares that model PV300 is in compliance with the essential requirements 
and other relevant provisions of Directive 1999/5/EC.

A copy of the original declaration of conformity can be found at the following Internet address:  
http://sharp-world.com/products/wireless_pda/index.html

Recycling Information

The RBRC™ Battery Recycling Seal on the Lithium-ion (Li-ion) battery/battery pack indicates Personal 
Communications Devices, LLC is voluntarily participating in an industry program to collect and recycle 
these battery/battery packs at the end of their useful life, when taken out of service in the United States 
or Canada. The RBRC™ program provides a convenient alternative to placing Li-ion batteries into the 
trash or municipal waste stream, which is illegal in some areas. Please call 1-800-822-8837 for information 
on Li-ion battery recycling in your area. Personal Communications Devices, LLC involvement in this 
program is part our commitment to preserving our environment and conserving our natural resources. 
(RBRC™ is a trademark of the Rechargeable Battery Recycling Corporation.)
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Legal Information
Danger® Service and End-User License Agreement
I IMPORTANT: PLEASE CAREFULLY READ THIS SERVICE AND END-USER LICENSE AGREEMENT (THE 
“AGREEMENT”) BETWEEN YOU AND DANGER, INC., A SUBSIDIARY OF MICROSOFT CORPORATION, 
(“DANGER”) BEFORE YOU USE YOUR WIRELESS DEVICE (THE “DEVICE”). YOUR USE OF THE DEVICE 
OR THE SERVICE FOR THE DEVICE SHALL CONSTITUTE YOUR BINDING ACCEPTANCE OF ALL OF 
THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE TERMS 
AND CONDITIONS OF THIS AGREEMENT, THEN YOU MAY NOT USE THE DEVICE OR THE SERVICE AND 
SHOULD PROMPTLY RETURN THE DEVICE TO THE PLACE WHERE YOU PURCHASED IT.

Danger owns and operates a service that enables certain features on your Device, including email, 
Internet access, instant messaging, address book, and calendar functions, and that also allows you to 
access such features from a Web site operated by Danger (the “Service”). Your use of the Service and the 
Software (as defined below) in the course of operating your Device is subject to the terms and condi-
tions of this Agreement. Danger reserves the right to change or modify any of the terms and conditions 
contained in this Agreement or any policy referenced herein at any time and in its sole discretion. You may 
access this agreement at www.danger.com/legal. If the Agreement is changed, we will post the new terms 
to such Web page. Any changes or modifications will be effective upon posting, and your continued use 
of the Service or Software after the posting of such changes will constitute your binding acceptance of the 
Agreement as revised.

1. Software
1.1 Definition. “Software” means any computer software, in executable code form, owned by Danger 
(or software owned by third parties, which Danger has the right to distribute or sublicense) and either 
pre-loaded on the Device at the time of manufacture or otherwise furnished to you by Danger in its sole 
discretion. “Software” includes the Danger® operating system and applications, including any and all 
updates to the same.

1.2 License Grant. Subject to the terms and conditions of this Agreement, Danger hereby grants to you 
a nonexclusive, nontransferable, nonsublicenseable license to use, perform, and display the Software 
using the Device upon which the Software was originally installed, and solely as necessary to operate the 
Software in accordance with the applicable documentation.

1.3 Restrictions. You may not (a) reproduce, distribute, sublicense, use for service-bureau purposes, sell, 
lease, or otherwise transfer the Software to any third parties; (b) modify, alter, improve, “hack,” or create 
derivative works of the Software; or (c) reverse-engineer, decompile, disassemble, reverse-assemble, or 
otherwise attempt to derive the source code of the Software.

1.4 Third-Party Software. You understand and agree that in addition to the Software, the Device may 
contain certain third-party software (“Third-Party Software”) the use of which may be subject to separate 
license agreements containing additional terms and conditions. Any such license agreements will be 
provided to you separately. You hereby agree to comply with all such additional terms and conditions in 
your use of the Third-Party Software.

2. Ownership. The Software is licensed to you, not sold. Danger and its licensors retain exclusive owner-
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ship of all proprietary rights, including all patent, copyright, trade secret, trademark and other intellectual 
property rights worldwide, in and to the Service and the Software (including any corrections, bug fixes, 
enhancements, updates or other modifications thereto). There are no implied licenses under this Agree-
ment, and all rights not expressly granted are hereby reserved.

3. Use of the Service

3.1 Wireless Service Provider. In addition to Danger’s terms and conditions set forth in this Agreement, 
you agree and acknowledge that your use of the Service is subject to your wireless carrier’s terms and 
conditions of service.

3.2 Privacy. You consent to the collection, use and disclosure of your personal information outlined in this 
section and in the Danger Service Privacy Notice. 

In order to provide you the Service, and to improve, enhance and diagnose issues with the Software and 
the Service, we may collect information about your use of the Software and the Service such as Web 
pages you view, the links you click and other actions you take using the Software and the Service, your 
usage of certain features of the Service and the number of messages you send and other similar infor-
mation (“Usage Information”).  This Usage Information is not associated with your account information 
without your consent except as specifically provided in the Danger Service Privacy Notice and is used 
and disclosed as described in the Danger Service Privacy Notice. We may automatically upload Usage 
Information from your Device. 

We may access or disclose information about you, your account and/or the content of your communi-
cations, in order to: (a) comply with the law or legal process served on us; (b) enforce and investigate 
potential violations of this Agreement; including use of the Service to participate in, or facilitate, activities 
that violate the law; (c) protect the rights, property or safety of Danger, its employees, its customers or the 
public; or (d) as otherwise disclosed in our Danger Service Privacy Notice.  

Personal information collected by Danger may be stored and processed in the United States or any other 
country or region in which Danger or its affiliates, subsidiaries or service providers maintain facilities. 
By using the Danger Service, you consent to any such transfer of information outside of your country or 
region.  

3.3 Your Account. All information that you provide in connection with your registration for the Service 
must be accurate. You will receive a password and username upon completing your registration. You are 
responsible for maintaining the confidentiality of the password and account information, and are fully 
responsible for all activities that occur under your password or account. You agree to immediately notify 
your wireless network operator of any unauthorized use of your password or account or any other breach 
of security.

3.4 Prohibited Activities. You agree not to use the Service to: (a) directly or indirectly violate any appli-
cable laws, rules, or regulations issued or promulgated by any competent government authority, includ-
ing without limitation any intellectual property laws, privacy laws, computer fraud or abuse statutes, or 
export control laws; (b) upload, post, email or transmit any content that you do not have the right to post 
or transmit under any law, contractual duty or fiduciary relationship; (c) upload, post, email or transmit 
any content that infringes a third party’s trademark, patent, trade secret, copyright, publicity, privacy, or 
other proprietary right; (d) upload, post, email or transmit any materials that are unlawful, untrue (includ-
ing incomplete, false or inaccurate biographical information), harassing, libelous, defamatory, abusive, 
tortuous, threatening, obscene, pornographic, indecent, hateful, abusive, or harmful (including but not 
limited to viruses, corrupted files, or any other similar software or programs); (e) violate, attack, or attempt 
to violate or attack the security, integrity, or availability of any network, service, or other computer system; 
(f) send mass unsolicited or unauthorized electronic messages or “spam”, including without limitation, 
promotions or advertisements for products or services; (g) send altered, deceptive or false source-identify-
ing information (including forged TCP/IP headers); or (h) use the Service in a manner that otherwise vio-

	 Legal Information	 95



lates Danger’s then-current Acceptable Use Policy, the latest version of which is available at www.danger.
com/legal. Violations of any of the above will be investigated by Danger and, where appropriate, Danger 
may either institute legal action, or cooperate with law enforcement authorities in bringing legal proceed-
ings, against users who violate this Agreement.

3.5 Third-Party Content and Services. In the course of using the Service, you may download to the Device 
content that is provided by third parties and/or access services and Web sites provided by third parties, 
including third-party Web sites accessible through links from the Service.  Danger is not responsible for 
the content, products, materials, or practices (including privacy practices) of any such Web sites or third-
parties.  You understand that by using the Service you may be exposed to third-party Web sites or content 
that you find offensive, indecent or otherwise objectionable. Danger makes no warranty, representation, 
endorsement, or guarantee regarding, and accepts no responsibility for, the quality, content, nature or 
reliability of third-party Web sites (including Web sites accessible by hyperlink from the Service) or third 
party products or services accessible via the Service.  Danger provides links to third-party Web sites for 
your convenience only and Danger does not control such Web sites.  Danger’s inclusion of links to third 
party Web sites or access to third party products does not imply any endorsement of the third parties or 
their products and services. It is your responsibility to review the privacy policies and terms of use that 
apply to third party Web sites you visit or to third party content and services you access.  In no event will 
Danger be liable to you in connection with any Web sites, content, products, services, materials, or prac-
tices of a third party.  

3.6 Consent for Internet Based Services. Danger provides Internet-based services with the Service. It may 
change or cancel them at any time. Certain features of the Service connect to Danger or service provider 
computer systems over the Internet. In some cases, you will not receive a separate notice when they 
connect. BY USING THESE FEATURES, YOU CONSENT TO THE TRANSMISSION OF THE INFORMATION 
DESCRIBED BELOW.  

	 (a) Computer Information. Features that access the Internet will send to the appropriate systems 
computer information, such as your Internet protocol address, each time the features access the Internet.  

	 (b) Automatic Update Feature. Each time you use the Service, the Service checks with Danger 
for a newer version of the Software. If found, the newer version automatically downloads and installs on 
your personal Device.  In certain cases, updates will be required and you will not be able to use certain 
features of the Service without first installing the Software update.

3.7 Uploading and Downloading of Information. You hereby agree and acknowledge: (a) that Software, 
data, and other information may be downloaded from Danger to your Device and requests for information 
may be uploaded from your Device to Danger on a regular basis; (b) that Danger makes no guarantee of, 
and is not responsible for, the accuracy or completeness of any downloaded information; and (c) that the 
Service may be inoperable from time-to-time and Danger shall incur no liability for such inoperability.  You 
also hereby agree and acknowledge that any information, content or software that you upload or down-
load using a particular Device model may not be available to you in the event that you switch to a different 
Device model.

4. Intellectual Property Rights

4.1 Copyright. All content included on the Device, including graphics, text, images, logos, button icons, 
images, audio and video clips and software, as well as the compilation of the content, is the property of 
Danger and/or its licensors (“Danger Material”) and is protected by U.S. and international copyright laws. 
Any unauthorized use of Danger Material may violate copyright, trademark or other laws. Additionally, 
certain other content, including, websites, photographs, images, text, graphics, video clips, audio record-
ings, or other content accessed or transmitted through the Service may be copyrighted by third parties 
and protected by U.S. and international copyright law. Materials that are copyrighted may be viewed as 
presented and are for personal use only. Unless otherwise authorized by law, you agree not to alter, falsify, 
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misrepresent, modify, copy, reproduce, republish, upload, post, transmit, distribute or otherwise utilize 
such materials without the express, written permission of the copyright holder. Unauthorized copying or 
distribution of copyrighted works is an infringement of the copyright holders’ rights. Pursuant to the Dig-
ital Millennium Copyright Act, Danger reserves the right to terminate the accounts of users of the Service 
who are infringers of the copyrights of others.

4.2 Trademarks. Danger®, hiptop®, the Danger logo, the hiptop logo, and the powered-by-danger logo 
are trademarks, service marks, and/or registered trademarks of Danger, Inc. in the United States and in 
other countries. You agree not to use Danger’s trademarks (i) to identify products or services that are not 
Danger’s, (ii) in any manner likely to cause confusion, (iii) in or as a part of your own trademarks, (iv) in a 
manner that implies that Danger sponsors or endorses your products or services or (v) in any manner that 
disparages or discredits Danger. You must have Danger’s prior written consent before you use Danger’s 
trademarks in any way.

5. No Monitoring; Necessary Disclosures. You acknowledge that Danger does not pre-screen or monitor 
content posted to or transmitted through the Service, but that Danger shall have the right (but not the obli-
gation) to remove any content in its sole discretion, including, without limitation, any content that violates 
this Agreement. In addition, Danger reserves the right to disclose all content that you upload, post, email, 
transmit or otherwise make available via the Service (whether or not directed to Danger) if required to do 
so by law or in the good faith belief that such disclosure is necessary or appropriate to conform to the law 
or comply with legal process served on Danger or its service partners, to protect and defend the rights or 
property of Danger, the Service, Danger’s service partners or end users, whether or not required to do so 
by law, or to protect the personal safety of our end users or the public.

6. Termination. You agree that Danger or its service partners, in their sole discretion, may immediately 
terminate your access to the Service (whether directly or through your wireless carrier) if they believe 
that you have violated the terms and conditions of this Agreement and/or the Acceptable Use Policy. You 
agree that any termination of your access to the Service may be effected without prior notice, and ac-
knowledge and agree that, upon termination, Danger and its service partners may immediately deactivate 
or delete your account and all related information, emails, files and other data in your account and/or 
bar any further access to such files or the Service. Further, you agree that neither Danger nor its service 
partners shall be liable to you for any termination of your access to the Service hereunder.

7. NO WARRANTIES. THE SERVICE AND SOFTWARE ARE PROVIDED BY DANGER ON AN “AS IS” BASIS. 
DANGER, ITS SUPPLIERS AND SERVICE PROVIDERS HEREBY DISCLAIM ALL REPRESENTATIONS 
OR WARRANTIES OF ANY KIND, WHETHER EXPRESS, IMPLIED, OR STATUTORY, RELATING TO THE 
SERVICE OR THE SOFTWARE (INCLUDING ANY INFORMATION, CONTENT, MATERIALS OR PRODUCTS 
THAT YOU MAY ACCESS THROUGH THE SERVICE), INCLUDING WITHOUT LIMITATION ANY IMPLIED 
WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, QUIET ENJOYMENT, 
NON-INFRINGEMENT OF THIRD PARTY RIGHTS, ACCURACY OF INFORMATIONAL CONTENT, AND 
ANY WARRANTIES ARISING FROM A COURSE OF DEALING OR USAGE OF TRADE. WITHOUT LIMITING 
THE FOREGOING, YOU ACKNOWLEDGE THAT DANGER, ITS SUPPLIERS AND SERVICE PROVIDERS DO 
NOT WARRANT OR REPRESENT THAT THE SERVICE OR THE SOFTWARE WILL MEET YOUR REQUIRE-
MENTS, THAT THE SERVICE OR THE SOFTWARE WILL BE TIMELY, SECURE, UNINTERRUPTED, OR 
ERROR-FREE, THAT DEFECTS IN THE SERVICE OR THE SOFTWARE WILL BE CORRECTED, THAT ANY 
CONTENT OR INFORMATION CONTAINED IN THE SERVICE OR ACCESSED THROUGH YOUR USE OF 
THE DEVICE WILL BE ACCURATE, COMPLETE, RELIABLE, OR ERROR-FREE, THAT THE SOFTWARE 
OR ANY MATERIALS AVAILABLE FOR DOWNLOAD FROM THE SERVICE WILL BE FREE OF VIRUSES 

	 Legal Information	 97



OR OTHER HARMFUL COMPONENTS, OR THAT THE SERVICE WILL BE FREE FROM UNAUTHORIZED 
ACCESS (INCLUDING THIRD PARTY HACKERS OR DENIAL OF SERVICE ATTACKS). FURTHER, AS THE 
WIRELESS CARRIER IS NOT CONTROLLED BY DANGER, NO WARRANTY IS MADE AS TO COVERAGE, 
AVAILABILITY OR GRADE OF SERVICE PROVIDED BY THE WIRELESS CARRIER. PLEASE NOTE THAT 
SOME JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO SOME OF THE 
ABOVE EXCLUSIONS MAY NOT APPLY TO YOU.

8. LIMITATION OF LIABILITY. IN NO EVENT SHALL DANGER, ITS SUPPLIERS OR SERVICE PROVIDERS 
BE LIABLE TO YOU FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, CONSEQUENTIAL, EXEM-
PLARY, PUNITIVE, OR OTHER DAMAGES (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF 
PROFITS, BUSINESS INTERRUPTION, LOSS OF INFORMATION OR DATA, OR OTHER PECUNIARY LOSS) 
RESULTING FROM YOUR ACCESS TO, OR USE OR INABILITY TO USE THE SERVICE OR SOFTWARE 
(INCLUDING AS A RESULT OF AN OUTAGE OF THE SERVICE PROVIDED BY YOUR WIRELESS CARRIER 
OR ANY OTHER THIRD-PARTY SERVICE PROVIDER, OR WITH RESPECT TO THE INFORMATION, SERV-
ICES, CONTENT OR ADVERTISEMENTS CONTAINED ON OR OTHERWISE ACCESSED THROUGH THE 
SERVICE. IN NO EVENT WILL DANGER, ITS SUPPLIERS OR SERVICE PROVIDERS BE LIABLE TO YOU 
IN CONNECTION WITH THE SERVICE OR THE SOFTWARE FOR ANY DAMAGES IN EXCESS OF TWO 
HUNDRED U.S. DOLLARS (U.S. $200).

9. Indemnity. You agree to defend, indemnify, and hold harmless Danger, its officers, directors, employ-
ees and agents, from and against any claims, actions or demands, including without limitation reasonable 
attorneys’ fees, made by any third party due to or resulting from your violation of this Agreement.

10. Export Controls. You agree and acknowledge that the Software may contain cryptographic functional-
ity the export of which is restricted under U.S. export control law. You will comply with all applicable laws 
and regulations in your activities under this Agreement, including without limitation all export laws and 
regulations of the U.S. Department of Commerce and all other U.S. agencies and authorities, including 
the Export Administration Regulations promulgated by the Bureau of Industry and Security (as codified 
in 15 C.F.R. Parts §§ 730-774). You expressly agree not to export or re-export the Software in violation of 
such laws or regulations, or without all required licenses and authorizations.

11. Government End Users. The Software is a “commercial item” as that term is defined at 48 C.F.R. 
2.101, consisting of “commercial computer software” and “commercial computer software documenta-
tion” as such terms are used in 48 C.F.R. 12.212. Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-
1 through 227.7202-4, all U.S. Government end users acquire the Software with only those rights set forth 
therein.

12. Applicable Law and Jurisdiction. You agree that this Agreement and all matters relating to the Service 
and the Software will be governed by the laws of the State of California, without giving effect to any princi-
ples of conflicts of laws that would require the application of the laws of a different state. You also consent 
to the exclusive jurisdiction and venue of the Superior Court of Santa Clara County for state claims and 
the Northern District of California for federal claims in all disputes arising out of or relating to the Software 
or the Service. The parties agree that the Uniform Computer Information Transaction Act (or any statutory 
implementation of it) and the United Nations Convention on the International Sale of Goods will not apply 
with respect to this Agreement or the parties’ relationship.

13. General Provisions. You are responsible for compliance with applicable local laws. This Agreement 
is personal to you, and you may not transfer, assign or delegate this Agreement to anyone without the 
express written permission of Danger. Any attempt by you to assign, transfer or delegate this Agreement 
without the express written permission of Danger shall be null and void. The paragraph headings in this 
Agreement, shown in boldface type, are included to help make the agreement easier to read and have no 
binding effect. The waiver of any breach or default, or any delay in exercising any rights shall not consti-
tute a waiver of any subsequent breach or default. This Agreement constitutes the complete and exclusive 

98	 Legal Information



agreement between you and Danger with respect to the subject matter hereof, and supersedes all prior 
oral or written understandings, communications or agreements. If for any reason a court of competent ju-
risdiction finds any provision of this Agreement, or portion thereof, to be unenforceable, that provision of 
the Agreement will be enforced to the maximum extent permissible so as to effect the intent of the parties, 
and the remainder of this Agreement will continue in full force and effect.

Danger® Service Privacy Statement
Microsoft and its subsidiary, Danger, Inc., (collectively “Microsoft”) are committed to protecting your 
privacy, while delivering software and services that bring you the performance, power, and convenience 
you desire in your personal computing.  This privacy statement explains many of the data collection and 
use practices of Microsoft’s Danger wireless data services, (“Danger Service”).  It does not apply to other 
online or offline Microsoft sites, products, or services.  This privacy statement does not apply to the data 
collection and use practices of your wireless network operator that offers the Danger Service.  

The Danger Service, operated on behalf of your wireless network operator, enables certain features on 
your wireless device, including email, Internet access, instant messaging, address book and calendar 
functions.  The Danger Service also includes a Web site operated by Microsoft (“Danger Service Web 
Site”) that users may use to access these features, as described more fully in the Reference Guide accom-
panying your wireless device.  

Collection and Use of Your Information

The information we collect from you will be used by Microsoft and its controlled subsidiaries and affiliates 
to enable the features you are using and provide the service(s) or carry out the transaction(s) you have 
requested or authorized.  It may also be used to analyze and improve Microsoft products and services.

We may send certain mandatory service communications such as welcome letters, billing reminders, 
information on technical service issues, and security announcements. Some Microsoft services may send 
periodic member letters that are considered part of the service. We may occasionally request your feed-
back, invite you to participate in surveys, or send you promotional mailings to inform you of other products 
or services available from Microsoft and its affiliates.

In order to offer you a more consistent and personalized experience in your interactions with Microsoft, 
information collected through one Microsoft service may be combined with information obtained through 
other Microsoft services. We may also supplement the information we collect with information obtained 
from other companies. For example, we may use services from other companies that enable us to derive a 
general geographic area based on your IP address in order to customize certain services to your geo-
graphic area.

Except as described in this statement, personal information you provide will not be transferred to third 
parties without your consent.  Your personal information may be shared with third parties for their use to 
fulfill your requests and purchases of products and services.  Additionally, we occasionally hire other com-
panies to provide limited services on our behalf, such as processing and collecting payments, servicing 
accounts, providing the products and services associated with the Danger Service, or performing statisti-
cal analysis of our services. We will only provide those companies the personal information they need to 
deliver the service, and they are prohibited from using that information for any other purpose. 

Microsoft may access or disclose information about you, including the content of your communications, 
in order to: (a) comply with the law or respond to lawful requests or legal process; (b) protect the rights or 
property of Microsoft or our customers, including the enforcement of our agreements or policies govern-
ing your use of the Danger Service; or (c) act on a good faith belief that such access or disclosure is neces-
sary to protect the personal safety of Microsoft employees, customers, or the public.
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Information that is collected by or sent to Microsoft by the Danger Service may be stored and processed in 
the United States or any other country in which Microsoft or its affiliates, subsidiaries, or service providers 
maintain facilities. Microsoft abides by the safe harbor framework as set forth by the U.S. Department of 
Commerce regarding the collection, use, and retention of data from the European Union.

Collection and Use of Information about Your Computer or Wireless Device

When you use Internet-enabled features of the Danger Service, information about your computer or 
wirless device (“standard computer information”) is sent to the Web sites you visit and online services 
you use. Microsoft uses standard computer information to provide you Internet-enabled services, to help 
improve our products and services, and for statistical analysis. Standard computer information typically in-
cludes information such as your IP address, operating system version, browser version, and regional and 
language settings. In some cases, standard computer information may also include hardware ID, which 
indicates the device manufacturer, device name, and version. If a particular feature or service sends infor-
mation to Microsoft, standard computer information will be sent as well.  

Collection and Use of Danger Service Usage Data

The Danger Service collects certain information about actions you take while using the Danger Service 
and how you use the Danger Service (“Usage Data”).  For example, the Danger Service automatically gath-
ers information regarding which Web pages are visited by users of the Danger Service.  In addition, data 
regarding usage of various features of the Danger Service is collected, such as how many email messages 
or IM messages are sent by a particular user or by users in the aggregate, the most popular Web sites vis-
ited by users of the Danger Service, the number of Web pages viewed at the Danger Service Web Site and 
other similar information.  Similarly, for network monitoring purposes, the Danger Service records how 
many devices in the aggregate are connected to the Danger Service in particular geographic locations, 
but the Danger Service does not automatically identify the location of individual devices or users.

Usage Data gathered from your use of the Danger Service is stored under an automatically generated 
identification number that will not be linked to information that identifies you or can be used to contact 
you without your consent, except as specifically provided in this privacy statement.  

Usage Data is used to effectively operate the Danger Service and enhance your experience using the 
Danger Service. For example, cached versions of the Web sites that are most frequently visited by users 
are stored on the Danger Service so that you can access them more quickly. Usage Data is also used to 
understand how certain features of the Danger Service are being used and to measure the costs of provid-
ing certain features. Usage Data may also be used to diagnose and correct problems with the Danger 
Service. In some cases, it may be necessary to link Usage Data relating to your use of the Danger Service 
with you individually in order to correct problems that you may be experiencing with the Danger Service. 
In general, the collection and use of Usage Data allows for continuing development of the Danger Service 
and the ability to provide improved features and services to users.  Usage Data may be shared with third 
parties for research, analysis, or other similar purposes. Usage Data will only be shared with third par-
ties if the information is disclosed in a manner that does not identify individual users to the third parties 
concerned.

Security of your information

Microsoft is committed to helping protect the security of your information. We use a variety of security 
technologies and procedures to help protect your information from unauthorized access, use, or disclo-
sure. For example, we store the information you provide on computer systems with limited access, which 
are located in controlled facilities. 
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Use of Cookies

Cookies are small text files that are placed on the hard drive of your computer by a Web site you visit. 
These files identify your computer and record your preferences and other data about your visit so that 
when you return to the site, the site knows who you are and can personalize your visit. The Danger Service 
Web Site uses cookies to personalize the site, improve users experience at the site, and to determine 
which areas and features of the site are most popular. You may set your browser to reject cookies, but this 
may affect your ability to use some parts of the Danger Service Web Site.

When you access the Internet using your wireless device, the Web sites you visit may use cookies. These 
cookies may be physically placed on your wireless device, they may be transferred to the Danger Service 
or may be placed on servers operated by third party Web site operators. This cookie-like functionality is in 
place for the same reasons and designed for the same purposes as cookies installed on your computer, 
but information collected from cookies by third parties is subject to their privacy practices rather than this 
privacy statement.

As technology advances and cookies provide more functionality, we may utilize them in different ways in 
the future. As we do so, this privacy statement will be updated to provide you with more information.

Changes to this privacy statement

We will occasionally update this privacy statement to reflect changes in our products, services, and cus-
tomer feedback. When we post changes, we will revise the “last updated” date at the top of this statement. 
If there are material changes to this statement or in how Microsoft will use your personal information, we 
will notify you either by posting a notice of such changes prior to implementing the change or by directly 
sending you a notification. We encourage you to periodically review this statement to be informed of how 
Microsoft is protecting your information. 

For More Information

Microsoft welcomes your comments regarding this privacy statement. If you have questions about this 
statement or believe that we have not adhered to it, please contact us here: privacy@danger.com.   

Specific features  

The remainder of this document will address the following specific features:

Danger Service

What This Feature Does: The Danger Service, operated on behalf of your wireless operator,  provides 
certain features on your wireless device, including email, Internet access, instant messaging, address 
book and calendar functions.

Information Collected, Processed, or Transmitted: Certain information that personally identifies you or al-
lows us to contact you may be collected, processed, transmitted and stored by the Danger Service, includ-
ing your name, which must be entered when you become a user of the Danger Service; the mobile phone 
number for the device you are registering and the email address assigned to you as a user of the Danger 
Service. In addition, if you use your wireless device to access third party products and services, such as 
instant messaging services, your screen name(s) and password(s) for these services will be stored.

You may transmit and store other personal information, such as your address book, calendar informa-
tion, to do lists, notes, tasks, photographs and the contents of emails you send and receive on the Danger 
Service, either through your wireless device or by uploading such information at the Danger Service Web 
Site. If you input such information directly on your wireless device, it is automatically synchronized with 
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and stored on the Danger Service and is available to you through both the device and the Danger Service 
Web Site.  You may also retrieve email from your existing email accounts with third party services by using 
protocols such as “POP.” When you set up mail accounts through the Danger Service, the email addresses 
and other information associated with these accounts and the content of the email messages sent to these 
accounts is collected and stored. 

Use of Information:  Personal information is used and collected to (a) operate and deliver the Danger 
Service, (b) process or collect payments and for other billing purposes, (c) to assist with questions about 
use of the Danger Service, (d) to anticipate and resolve problems with your use of the Danger Service and 
(e) to alert you to new products, product upgrades, software upgrades, changes to the service, technical 
and administrative issues, special offers and other information related to the Danger Service.  Personal 
information may be shared with your wireless network operator to further the purposes described in this 
“Use of Information” section. Except in the very limited circumstances outlined in this privacy statement, 
the contents of data you transmit and/or store on the Danger Service, such as the content of your address 
book, notes, tasks, pictures and the contents of messages and emails you send and receive will not be 
shared with your wireless network operator. Your Personal Information will not be shared with other third 
parties without your consent, except in the very limited circumstances outlined in this privacy statement. 
Your Personal Information is not otherwise sold, marketed, or shared with third parties without your per-
mission.  

Choice/Control: You have the right to access and edit the personal information you have provided in con-
nection with your use of the Danger Service.  You may make such changes on your wireless device, at the 
Danger Service Web Site or by contacting your wireless operator.

Location Based Services  

What This Feature Does:  The geographic location of your device (“Location Information”) may be col-
lected, maintained, stored and displayed in order to enable certain third party location-sharing services 
that you request on your device.  

Information Collected, Processed, or Transmitted:  Location Information may be derived from your wire-
less network operator, certain third party service providers, or directly from your device. This Location 
Information may be transmitted, even when you are not using a third party location-sharing service.   

Use of Information:  Location Information is used to deliver the third-party services that you have request-
ed.   

Choice/Control:  Your Location Information is displayed and shared with others only in accordance with 
your privacy and opt-in settings.  

One-Year Limited Warranty

Personal Communications Devices, LLC (the Company) warrants to the original retail purchaser of this 
handheld portable cellular telephone, that should this product or any part thereof during normal con-
sumer usage and conditions, be proven defective in material or workmanship that results in product 
failure within the first twelve (12) month period from the date of purchase, such defect(s) will be repaired 
or replaced (with new or rebuilt parts) at the Company’s option, without charge for parts or labor directly 
related to the defect(s).

The antenna, keypad, display, rechargeable battery and battery charger, if included, are similarly war-
ranted for twelve (12) months from date of purchase. 
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This Warranty extends only to consumers who purchase the product in the United States or Canada and it 
is not transferable or assignable.
This Warranty does not apply to:

(a)	 Product subjected to abnormal use or conditions, accident, mishandling, neglect, unauthorized 
alteration, misuse, improper installation or repair or improper storage;

(b)	 Product whose mechanical serial number or electronic serial number has been removed, altered or 
defaced.

(c)	 Damage from exposure to moisture, humidity, excessive temperatures or extreme environmental 
conditions;

(d)	 Damage resulting from connection to, or use of any accessory or other product not approved or 
authorized by the Company;

(e)	 Defects in appearance, cosmetic, decorative or structural items such as framing and non-operative 
parts;

(f)	 Product damaged from external causes such as fire, flooding, dirt, sand, weather conditions, battery 
leakage, blown fuse, theft or improper usage of any electrical source.

The Company disclaims liability for removal or reinstallation of the product, for geographic coverage, 
for inadequate signal reception by the antenna or for communications range or operation of the cellular 
system as a whole. 

When sending your wireless device to Personal Communications Devices, LLC for repair or service, 
please note that any personal data or software stored on the device may be inadvertently erased or al-
tered. Therefore, we strongly recommend you make a back up copy of all data and software contained on 
your device before submitting it for repair or service. This includes all contact lists, downloads (i.e., third-
party software applications, ringtones, games and graphics) and any other data added to your device. In 
addition, if your wireless device uses a SIM or Multimedia card, please remove the card before submitting 
the device and store for later use when your device is returned, Personal Communications Devices, LLC is 
not responsible for and does not guarantee restoration of any third-party software, personal information 
or memory data contained in, stored on, or integrated with any wireless device, whether under warranty or 
not, returned to Personal Communications Devices, LLC for repair or service. 

To obtain repairs or replacement within the terms of this Warranty, the product should be delivered with 
proof of Warranty coverage (e.g., dated bill of sale), the consumer’s return address, daytime phone 
number and/or fax number and complete description of the problem, transportation prepaid, to the 
Company at the address shown below or to the place of purchase for repair or replacement processing. 
In addition, for reference to an authorized Warranty station in your area, you may telephone in the United 
States (800) 229-1235, and in Canada (800) 465-9672 (in Ontario call 416-695-3060).

THE EXTENT OF THE COMPANY’S LIABILITY UNDER THIS WARRANTY IS LIMITED TO THE REPAIR OR 
REPLACEMENT PROVIDED ABOVE AND, IN NO EVENT, SHALL THE COMPANY’S LIABILITY EXCEED 
THE PURCHASE PRICE PAID BY PURCHASER FOR THE PRODUCT.

ANY IMPLIED WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE, SHALL BE LIMITED TO THE DURATION OF THIS WRITTEN WARRANTY. 
ANY ACTION FOR BREACH OF ANY WARRANTY MUST BE BROUGHT WITHIN A PERIOD OF 18 MONTHS 
FROM DATE OF ORIGINAL PURCHASE. IN NO CASE SHALL THE COMPANY BE LIABLE FOR ANY SPECIAL 
CONSEQUENTIAL OR INCIDENTAL DAMAGES FOR BREACH OF THIS OR ANY OTHER WARRANTY, EX-
PRESS OR IMPLIED, WHATSOEVER. THE COMPANY SHALL NOT BE LIABLE FOR THE DELAY IN RENDER-
ING SERVICE UNDER THIS WARRANTY OR LOSS OF USE DURING THE TIME THE PRODUCT IS BEING 
REPAIRED OR REPLACED.
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No person or representative is authorized to assume for the Company any liability other than expressed 
herein in connection with the sale of this product.
Some states or provinces do not allow limitations on how long an implied warranty lasts or the exclusion 
or limitation of incidental or consequential damage so the above limitation or exclusions may not apply 
to you. This Warranty gives you specific legal rights, and you may also have other rights, which vary from 
state to state or province to province.

IN USA:		  Personal Communications Devices, LLC 
		  555 Wireless Blvd. 
		  Hauppauge, NY  11788 
		  (800) 229-1235
IN CANADA:	 PCD Communications Canada, LTD 
		  5535 Eglinton Avenue West 
		  Suite# 234 
		  Toronto, ON M9C 5K5 
		  (800) 465-9672

Additional Information
Service not available everywhere; for details see coverage maps at T-Mobile.com. All T-Mobile® rate plans 
require credit approval, activation on a qualified T-Mobile rate plan, per line activation fee and minimum 
1- or 2-year agreement may be required. $200/line early cancellation fee applies to 1-and 2-year agree-
ments. You will be charged for all data sent by or to you through the network, regardless of whether or not 
it is received. Character length/file size of messages/attachments may be limited. T-Mobile is not liable 
for content of messages/attachments, or for any failures, delays or errors in any T-Mobile-generated alerts 
or notifications. You obtain no rights in preloaded content: duration of use may be limited; may be stored 
solely for use with your device; may not be sublicensed, transferred to other devices/SIM cards, or other-
wise disseminated. Call duration and/or your continued eligibility for service or any rate plan may be lim-
ited or terminated for (a) consumer protection purposes, (b) abusive conduct or abnormal call pattern(s), 
or (c) significant roaming.  Device is intended for use on the T-Mobile network. See pricing, services and 
device brochures, and T-Mobile’s Terms and Conditions (including mandatory arbitration) at T-Mobile.
com for additional rate plan information, charges for features and services, and restrictions and details. 
T-Mobile, the magenta color, and t-zones are registered trademarks of Deutsche Telekom AG. myFaves, 
the myFaves design, and Sidekick are registered trademarks of T-Mobile USA, Inc. 

Java and all Java based trademarks and logos are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. or other countries.
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Bluetooth is a trademark of the Bluetooth SIG, Inc.

The Bluetooth word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks by 
Sharp is under license. Other trademarks and trade names are those of their respective owners.

 
MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson. 

 
microSDHC™ is a trademark.

Copyright © 1985, 1986, 1988, 1992, 1993, 1999 The Regents of the University of California.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the University nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS “AS IS’’ AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Portions of software licensed under the above license include the following additional copyright notices 
and additional conditions. 

Copyright © 2004 Albert Chin-A-Young. This code is derived from software contributed to Berkeley by 
Diomidis Spinellis and James A. Woods, derived from original work by Spencer Thomas and Joseph Orost.

Copyright © 1995, 1997 Wolfgang Solfrank. Copyright © 1995 Martin Husemann. All advertising materials 
mentioning features or use of this software must display the following acknowledgement: This product 
includes software developed by Martin Husemann and Wolfgang Solfrank.
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This code is derived from software contributed to Berkeley by Berkeley Software Design, Inc.

Copyright © UNIX System Laboratories, Inc. All or some portions of this file are derived from material 
licensed to the University of California by American Telephone and Telegraph Co. or Unix System 
Laboratories, Inc. and are reproduced herein with the permission of UNIX System Laboratories, Inc.

All advertising materials mentioning features or use of this software must display the following 
acknowledgement: This product includes software developed by the University of California, Berkeley and 
its contributors.

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING VIDEO IN COMPLIANCE 
WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/OR (ii) DECODING MPEG-4 VIDEO THAT 
WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/
OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED BY MPEG LA TO PROVIDE MPEG-4 VIDEO. 
NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION 
INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL AND COMMERCIAL USES AND LICENSING 
MAY BE OBTAINED FROM MPEG LA, LLC. SEE HTTP://WWW.MPEGLA.COM.

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE FOR 
ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD EXCEPT THAT AN ADDITIONAL 
LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR ENCODING IN CONNECTION WITH (i) 
DATA STORED OR REPLICATED IN PHYSICAL MEDIA WHICH IS PAID FOR ON A TITLE BY TITLE BASIS 
AND/OR (ii) DATA WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END 
USER FOR PERMANENT STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED 
FROM MPEG LA, LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Copies of the openmap software files incorporated into this software are available at http://openmap.bbn.
com.
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